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Welcome to Hello Engines!
Hello Engines! is a comprehensive piece of software for search engine optimization. The program is offered in three different editions, aimed at beginners
(Freeware and Personal Edition), professional webmasters and companies who maintain and/or own various website projects (Professional
Edition). The Professional Edition corresponds to the SEO tool ASEOPS.
The program offers a number of tools which will support you in your daily work regarding search engine optimization to get a better position in Google & Co.
in the long term. Hello Engines! automates many processes and helps you to gather information and reports in one central place. Test your website and
its ranking, find new keywords and much more. That way you will be able to reach the target group which is meant to find you on the Internet.
For the new features of the current version visit ASEOPS.com and Hello-Engines.com.
If you want to start working with Hello Engines! straight away, go to Quick start. In addition, the program includes a number of help options which you
can review if you have any further questions or problems.

What's new in Hello Engines!
Our software is being developed and updated constantly. In order to see what makes this software better than the previous versions please visit one of our
websites, depending on what edition you are using: ASEOPS.com or Hello-Engines.com.

Setup
To install Hello Engines on your computer, please perform the following actions:
1. Go to the Hello Engines website and select the Download menu.
2. Click the indicated download link.
3. Then select the folder where you wish to save the file or execute the file directly.
4. Follow the instructions of the installation wizard.
5. After successful installation, always go to the Update Manager. This way, you make sure that you are using the latest version of Hello
Engines!.
6. Go to File > Unlock to request a free activation key and enter your valid unlock code you received by e-mail to unlock the program.

System requirements
* Operating system: Windows 8, 7, Vista, NT4, 2000, XP, 98, ME or 2003
* 400 MHz Intel Pentium II processor or later
* 512 MB RAM or more
* Internet Explorer 8 or higher
* 45 MB of free hard disk space

Unlock to full version
To work with Hello Engines!, you need to unlock the software.
Important: To unlock Hello Engines! you need to be connected to the internet.
You can either select the option Unlock Now on the first program start or go to the File menu in the test version and select Unlock. If you already have
an unlock code, select Step 2 - Unlock to full version.

Step 1: User information
Here you enter your personal details.
Important: Please enter a valid email address. You need to enter an email address that you can access during the activation. Do not use email
addresses of third persons as you need to enter the activation key which is sent to that address to complete the activation.

Step 2: Request activation key
Click the Request Activation Key button. Your activation key is sent to the specified email address within a few minutes.
Then enter the activation key into the Activation Key field.
Important: You can simply request a new activation key if you need to activate your software again. You do not need to save your activation key.

Step 3: Enter unlock code
Enter the unlock code which you received when ordering the software.
To unlock the program as a freeware, click on Get a free unlock code.
Afterwards click Next and exit the wizard.

Deactivate Hello Engines!
With a valid unlock code, you can unlock Hello Engines! on up to two computers at the same time.
If you want to move Hello Engines! to another PC, you will need to deactivate it on the old computer. Only then you will be able to use the unlock code on
another PC.
To do so, please click Deactivate Software in the File menu and confirm to deactivate it.
Important! This also applies when you re-install your operating system. Please make sure to deactivate Hello Engines! first.
If you should forget to deactivate it or if it is no longer possible because the computer has crashed, please contact our support to have it deactivated.

Update Manager
The Update Manager enables you to keep your software up-to-date at all times. It automatically checks via the Internet whether a newer version of Hello
Engines! is available.
Use this command regularly to ensure that you are always working with the most current version.
If you have problems, make sure no antivirus software or firewalls may stop the Update Manager from connecting to the Internet. If the problems persist,
download product updates manually from the Hello Engines! website.
From the File menu, select the Update Manager to start it.
Click Start on the Welcome Page to search for available updates.
If the program finds an update, leave the check box activated to install the according program version.
Note: Only free updates will be installed.
If you would like to use the Update Manager at each startup, you can specify that in the Options.

Help and support
To get help on a specific topic:
If you are using Hello Engines! for the first time, read Quick Start.
Search for the respective term in the Help Index.
For context-sensitive help press F1 while executing Hello Engines! or click the Help button.
Refer to the user manual.
Read the FAQs; all frequently asked questions are answered here.
Post your questions on the Hello Engines! Support Forum (open to all users), or look for answers to your questions there.
Contact our Support.
Take a look at the online help.

Migrate from previous versions
In order to migrate projects from previous versions click on File > Import and select a .sit-file.
In order to migrate templates from previous versions copy the .template-files from the old configuration directory and paste them into the AppData-sub
folder of the projects directory.

Note: The configuration directory is located by default at "C:\Users\Username\AppData\Roaming\AceBIT\Hello Engines 9".
Note: Starting from Hello Engines! 9 templates are stored in the AppData-sub folder of the projects directory. By default this folder is located at
"C:\Users\Username\Documents\Hello Engines 9\AppData".

Quick Start
Do you want to start immediately without having read the entire user manual? The following instructions will help you:

1. Go to the Projects section and click Add to create a new project based on your URL. Fill in the most important data and select a primary
keyword and search engine for the project.

2. Navigate to the Analysis section and have your website analyzed. You will receive an overall rating for your site which will show you the
current state regarding optimization. In addition, you can check the HTML code, links and load time of your website in this section of Hello
Engines!.

3. In the Keywords section you can create keywords and keyword lists and find new keyword combinations using different keyword tools.
4. To determine the current ranking of your website for specific keywords go to the Ranking section. Here you can also see a history of your
ranking results.

5. With the help of different modules you can use tools to create sitemaps and meta tags or validate your HTML code. Additionally, you can report
your website to several search engines. The software also helps you determine a number of details about your site in regards to backlinks and
pagerank distribution as an example. All crucial analyses can be put into a report and exported.

6. Go to the Reports section and print or save all the necessary reports, so that you can compare your current result to the one which you achieve
during the optimization process.

What does

Hello Engines!

do?

Hello Engines! is a software to help you making your website more visible on the Internet. It helps you to detect and improve weaknesses and to find the
right methods to ensure that your website is found, that is, it helps you to optimize your website for search engines.
These are the features of Hello Engines!:
Convenient management of different projects
Detailed analysis of all important Ranking criteria
A ranking query and a keywords section for finding and analyzing keywords for your website (from Hello Engines! Professional)
Numerous tools, which allow you to create detailed optimization measures for your website
Well-structured reports which show the results of your work at a glance

The user interface
Hello Engines! is a powerful application comprising many features. One of the design objectives for the user interface was to automate as many processes
as possible, so that handling the program is as easy for users as possible.
The user interface is separated into five (Hello Engines! Freeware and Personal) and eight (Hello Engines! Professional) related modules:
Projects
Analysis
Optimization
Keywords (from Hello Engines! Professional)
Backlinks (from Hello Engines! Professional)
Ranking (from Hello Engines! Professional)
Tools
Reports
Via the main menu, you can access the Tools menu with some additional wizards.

Projects
The Projects section consists of two modules:
Project Files: Here you create new projects with URLs and other data, like keywords and a primary search engine for which you would like to
optimize with Hello Engines!.
Templates: Here you can create templates which you would like to use for several projects, as for example for websites or keyword sets, for
which you would like to optimize.

Project Files
In this program section you can create your projects which you would like to optimize with Hello Engines!. Apart from the URL of your website, you will
have to enter some basic information and select the search engine and keyword for which you would like to optimize your site.
Add: Click Add to start the New Project Wizard which will help you to enter the data which is needed. Afterwards, all projects will be shown in
the Project list with the according information and a screenshot of the website on the right side. Below you can see the SEO Checklist for the
selected project which can be used to work through the list of measures which need to be taken. Thus you can manage several projects without
losing track.
Open: Select a project from the list and click Open to select it or alternatively double-click it.
Close: Accordingly, you can use the Close button once you are finished with a project.
Properties: If you would like to make changes to a project, click the Properties button to open it where you will have the opportunity to apply
the desired changes. Then, click the Save button.
Duplicate: In case you have a project which is very similar to an existing project, you can Duplicate a project and make the necessary
changes.
Note: If you are managing many projects you can add and use folders for a better overview.

New Project Wizard
The New Project Wizard can be accessed in the Project Files section and will help you setting up your website project.

1. URL
Enter the URL for this project. Normally, this will be the main site of your website project, that is http://www.mysite.com
Alternatively, click on Local File if you want to analyze a HTML document which is saved on your disk.
When you are ready, click Next and Hello Engines! will start retrieving the available data from the specified website.

2. Website Data
On this form of the wizard, enter some basic descriptions about your website. Hello Engines! will fill in most of the details based on the information which
was found on the website. If the according information was not found on the website or you would like to make any amendments, you can simply enter the
text manually. A comment can be added containing some additional information like a delivery date. Furthermore, you can load information from a
template on the right side or save it.
When you are ready, click Next.

3. Project Keywords
Here, you can select the Preferred Search Engine for which you would like to optimize your website and define the number of matches to be checked..
In addition, please select your Primary Keyword, that is the keyword for which you would like to optimize your site primarily and some additional
keywords. Hello Engines! will offer you some keywords according to the content which it found on your website. You can either select one of those
keywords as primary keywords if you click the arrow button on the right, or choose a different keyword by typing it manually. You can also load that
information from a template or save it as such. Load from Collection allows you to use the keywords you created in the Keywords section. Alternatively, you
can load keywords from any text file.
Note: You need to select a primary keyword and a preferred search engine to be able to continue.
When you are ready, click Next.

4. Access Data
Specify here, where the according HTML file is stored which you would like to optimize. As Website Location select either your local system or FTP Server.
You can test the configured connection by clicking Test Connection.
If you do not have direct access to the files you can check the option No access to source files. Remember that without access to the files you can't edit
the HTML code directly.

5. Advanced Settings
The analysis settings which Hello Engines! uses by default can be adapted on this tab. The Scan Depth refers the link checking and determines to what
extend the program will check. The Max. number of pages determines how many documents will be considered for the technical analysis. At Max.
ranking results you can determine how many positions in search engines will be checked, which is the top 10 by default. In addition, you can set some
skip options for websites you would like to skip by default.
In the Additional section you can add some further information to your project:
The Report template is used to customize reports which are created inside of this project.
The Customer Data template allows you to save information about the customer who is connected to that specific project.
The Submission Data template is only used for the submission to search engines.
Click New Template if you want to use any of these three templates to create one.
Note: All advanced settings are optional.
When you are ready, click Next.

6. Competitors
You can define a list of competitors for your project.
No competitor
Top 10 URLs from the preferred engine by primary keyword: The software will automatically retrieve a list of the 10 best placed results
in the search engine.
Define manually:Enter your own list of competitors.
When you are ready, click Next.

7. Wizard Completion
After you have filled in all the necessary fields, you can complete the New Project Wizard by clicking Finish.
By default, Hello Engines! will now start to analyze your website.
If you want to run the analysis later, uncheck Start Website Analysis.

Project Properties
In order to adapt a project upon its completion, open the project’s Properties. Here, you have five tabs at your disposal.

Website Data
In this form of the Project Wizard, you enter your website’s basic descriptions. Most form fields are already filled out by Hello Engines! with the
information the software has found on the website in question.
This information is also sent to search engines during Automatic and Manual Submission.
If you would like to change the filled-in information, you can do this here manually.
If certain information has not been filled-in as it is not (yet) to be found on your website, you may fill this data in manually.
URL: Enter the project's URL. Normally, this is the main page of your website project, e.g. http://www.mysite.com.
Description: Enter a description for your website.
NOTE: You can vary your description that is submitted to search engines, by splitting it into multiple parts with different variables.
Hello Engines! uses the following delimiters { } and |
e.g.
{This} {is|was} {my|our|the} {first|latest} {website|project} {for fun|submission|this year}
Hello Engines! will use a variable from within each unit marked by the brackets.
Local File: Instead of entering a URL, you may click on this button in order to analyze an HTML file stored on your PC.
Update Screenshot: Creates another preview thumbnail of your website.
Update Site Age: Updates the date when your site was firstly registered.
Load from Template/Save as Template: All of the above information you may also load from a template instead of typing it in manually, or
else save in form of a template in order to use it again in future projects.

Keywords
On this tab, you find the following details concerning search engines and keywords:
Preferred Search Engine: Here you may choose the search engine which you prefer. In the drop-down list, Hello Engines! offers you some
search engines to choose from.
Max. Matches: Defines how many results should be checked in the preferred search engine.
Primary Keyword/Phrase: Determine the keyword for which your website shall be optimized. This keyword may be a single word or a
phrase, and you may type it in manually or select it from the drop-down list. The drop-down list in question offers keywords that correspond to
the content of your website or that are proposed in the list of additional keywords below.
Alternate Keywords for the Home Page: Proposes additional key phrases for your site’s home page.
Load from Template/Save as Template: All of the above information you may also load from a template instead of typing it in manually, or
else save in form of a template in order to use it again in future projects.
Add Keywords: A click on this button opens up a window in which you may manually enter up to 15 keywords.
Load from Collection: Via this button you may load keywords from the corresponding selection.
Load from File: This button lets you load keywords from a file, e.g. a text file or a CSV file.

Access Data
This tab provides the following options:
Default Filename on Server: Here you may choose the standard file, e.g. index.htm(l) or default.htm(l).
No access to source files: Check this option if you do not have direct access to the source files. In this case, the software will download the
files in write-protected mode. If you uncheck this option, i.e. if you can access the source files, the buttons and fields below will become
activated.
Website Location: Choose here where the website is located. You may select from Local System, FTP Server and SFTP Server. According to
your location selection, you will then enter the location’s access data below.
Test Connection: Click here in order to test your connection settings.

Advanced
This tab allows you to modify the analysis settings which Hello Engines! uses by default.
Max. Link Level: This option determines the level up to which Hello Engines! will analyze links, i.e. how 'deep' the software will scan your
website’s links.
Max. number of pages: Here you determine the maximum number of documents that shall be analyzed by Hello Engines!.
Max. ranking results: Determine how many positions among search engines will be analyzed. Usually, only the top 10 are queried.
Scheduled Ranking/Submission: By means of this function, you can let the ranking query and/or the submission to search engines be
carried out automatically. A click onto the button Settings opens the Windows Task Planer who helps you to configure the precise settings.
When you are ready, click OK to save the changes or Cancel to discard the changes.

SEO Checklist
There are numerous factors which are important for successful search engine optimization and which you should thus bear in mind after creating the actual
website.
The SEO Checklist in Hello Engines! offers you a check list with which you can carry out these steps one by one. That way you can always maintain an
overview even with several projects.
The list consists of 12 steps and is divided into four columns:
Task: Here are listed the twelve basic steps related to search engine optimization. If you double-click onto a task, you will see its single
subtasks. After you have carried out a certain subtask and thus consider it as completed, you can check the box at the left of the respective
subtask.
Task Status: Here you see your progress within the SEO check list. If you mark a certain task as completed, its task status is set to "Done." At
the same time, the status of the subordinated task, to which this subtask belongs, rises. In this way, you always see at first sight how much
you still have to do at how many tasks.
Program Functions: In this column, you see the function by means of which you can check or carry out a certain task (e.g. find out the
number of competitors by using the keywords tool). A click onto the corresponding functions leads you directly to the respective module.
Comments: This column shows a description of the task that is selected in the colon at the left.

Templates
In the Templates module you can create templates which you want to use for several of your projects. In addition, you can edit templates which you
created from a project.
Select the kind of template you want to create from the available tabs. Then click New Template to create an according template in this category.
There are the following possibilities:
Websites
Keyword Sets
Customers
Submission Data
Access Data
Report Templates
If you have already existing templates, you can select one in the list and click Edit Template to change it.
Of course, you can also Delete a template.
On the right side of the toolbar you can change the item View by selecting the desired option.

Template Websites
First of all, enter a name for your template. Then you can add or edit all or some of the following information:
Title: Enter the title of your website
URL: Enter the URL of your website
Country: Select the country where which your website is made, otherwise select International.
Language: Select the language of your website
Description: Enter a description on what your website is about and which topics it covers.
When you are ready, click OK to save the template.

Template Keyword Sets
If you create a new template and choose the Keyword Set option, you may indicate following information:
Name: First, indicate a name for this template with keywords sets.
Keyword: Here, you can enter the primary keyword of your website as well as single search terms or combinations of search terms. By
entering characters into the field Keyword, the buttons at the right of the field (Add and Replace) become active.
Add: If you clin onto this button, the term entered in the Keyword field is taken over into the list below.
Replace: With this function, you may edit or entirely replace keywords in the list. To do so, you first need to click onto one of the keywords in
the list. This term will then be shown in the Keyword field. Now you edit the term in the Keyword field as desired. In this way, the buttons
Add and Replace become active so that you may now use them.
Current Project: Imports the keywords from the project's properties.
Load from File: This button allows you to load keywords from a file, e.g. a text file.
Load from URL: With this function you may load keywords directly from a URL.
Clipboard: By clicking onto this button, you may import keywords from the clipboard.
Delete/Clear: These options delete one viz. all keywords from the list above.
When you are ready, click OK to save the keyword set.

Template Customers
First of all, enter a name for the template you are creating.
Then you can enter the First Name, Last Name, E-Mail, Company, some contact information of a client and select a Salutation.
When you are ready, click OK to save the customer.

Template Submission Data
This template is only used to submit your website to search engines. The information is required by some search engines.
First of all, enter a name for the Submission Data template.
Then, fill in all the fields in the webmaster and organisation sections, if possible.
A User Name and Password are required by some search engines when registering. Please be careful that you are not entering a password which you are
using for some confidential log-in as well.
Note: Please be careful about the e-mail address you enter as it could be abused by spammers.
When you are ready, click OK to save the template.

Template Access Data
First of all, enter a name for the access data template.
In addition, please specify where the according HTML file is stored which you would like to optimize. As Website Location select either your local system or
FTP Server.
When you are ready, click OK to save the template.

Template Report Templates
In Hello Engines! you can generate a report which can be adapted to the format and style you like. For this you need to go to the Templates module,
select Report Templates and click on New Template.
Name: First of all, enter a name for your template.
Style Sheet: In this section, you may change the report's appearance. To do so, you can either select a default style sheet or a custom one. If
you choose the custom option, you can load a CSS file by clicking onto the Select button.
Additionally, you may set and change the report's attributes:
Report Description: Here you can change the report description in the report's heading. Just enter your text into the text field or adapt the
default text.
Report Logo: Here you may determine the report's logo. The selected logo will be displayed in the window beneath it. If you click onto the
Select button, you may select your own logo, e.g. your company's logo. If you click onto Restore Default, the Hello Engines! logo will be
used.
Report Copyright: Furthermore, you have the possibility to change the copyright in the report's footer.
When you are ready, click OK to save the template.

Analysis
The Analysis section will help you to get an overview of the current status of your website project. This information is needed to determine which
necessary improvements need to be made and which weaknesses and errors need to be revised or corrected.
It is divided into the following module:
Website Analysis
Analysis Report
Website Rating
SEO Analyzer

Website Analysis
The Website Analysis module will help you to get an overview of the current status of your web project. In addition, this information is needed to
determine which the necessary improvements are and which weaknesses and errors need to be revised or corrected.
Start Analysis: Click here in order to launch your website’s analysis. Thereupon, Hello Engines! will download the necessary data from and
about your website. If you would like to exclude certain aspects in the list from the analysis, simply uncheck these elements.

• Cancel: In the progress window, you may click on the Cancel button in order to stop the analysis before its end.
• Pause: Additionally, you can click onto Pause in order to stop the analysis temporarily. To continue the analysis again, click onto the
Continue button.

• Save Analysis in History: A click on the small arrow of the Start Analysis button opens up a dialog window in which you can
determine that the analysis’ history shall be saved.

• Auto-create New Report: A click on the small arrow of the Start Analysis button opens up a dialog window in which you can
determine that a new report should be created automatically after the analysis is completed.
Analysis Settings: Here you can import or export custom presets for analyses.
Select: This function either checks or unchecks all of the elements in the list for the analysis, depending on whether you choose Check All or
Uncheck All.
History: Click here in order to see the dates of the last analysis.
Once the analysis is complete, a window containing the following information is displayed:
Number of analyzed website elements, found errors and generated warnings
Overall rating of the website (from 0,00% to 100,00%)
Go to Optimization Area
View Complete Report.
Note: You can change the importance and weight of the analysis elements in the Hello Engines! Program Options on the Custom Ratings tab.

Analysis Report
The Analysis Report in Hello Engines! comprises the results of the analysis which was done in the Website Analysis section.
All listed results are clearly arranged, so that you can easily determine the weak and already improved parts of a website. This is useful if you want to show
the results to a customer of yours or want to have an overview of the work you have done for your own website.
Note: Please execute the query in the module Website Analysis anew in case you have changed the keywords or search engines.
The module Analysis Report consists of three tabs: Problems found, Overall View and Report.

1. Problems found
This tab provides an overview of all the errors and problems which Hello Engines! has found regarding your website and the primary keyword and search
engine.
In this tab’s toolbar, you have the following options:
Fix Problem: If you would like to fix a problem, click onto the corresponding element in the list and then on this button. Thereupon, Hello
Engines! will show a window in which you can start measures in order to fix or improve the problem as indicated in the recommendation.
Set Optimized: In case you prefer to take a recommended optimization measure yourself or do not want to change anything, you can set the
status of that element to "Optimized." To do so, click onto the corresponding element in the list and then on the button Set Optimized.
Exclude Element: If an element is not relevant for your website at all, you can click on this option. This way, the optimization status of this
element is set to "Excluded." The element may later be added again.
Reset Element: Resets the status of the selected element to Unknown. You may check it again at the next analysis.
Export: This function allows you to export the analysis report, e.g. into a PDF or CSV file.
Beneath the toolbar, you will find information regarding the detected problems, e.g. their URL, the number of problems (HTML Validator) and their total
size.

2. Overall view
This tab provides a complete list of all the measures which are important for search engine optimization and which Hello Engines! checks for the primary
keyword and search engine you selected in your project.
They are sorted by superior categories which are:
Technical analysis
Site Rank
Site Popularity
Search engines appearance
Social Bookmarking
Ranking Analysis
SEO Analysis
Each category consists of one or more optimization measures. You can display or hide these measures by clicking on the box with the plus or minus symbol
at the left of this measure.
The table shows for each measure its description, importance and optimization status.
Fix Problem: If you would like to fix a problem, click on the corresponding element in the list and then onto this button. Thereupon, Hello
Engines! will display a window in which you can start measures in order to fix or improve the problem as indicated in the recommendation. If
the correction has been successful, you can set the measure’s optimization status to "Optimized."
Set Optimized: In case you prefer to take a recommended optimization measure yourself or do not want to change anything, you can set the
status of that element to "Optimized." To do so, click on the corresponding element in the list and then on the button Set Optimized.
Exclude Element: If an element is not relevant for your website at all, you can click on this option. This way, the optimization status of this
element is set to "Excluded." The element may later be added again.
Reset Element: Resets the status of the selected element to Unknown. You may check it again at the next analysis.
Export: This function allows you to export the analysis report, e.g. into a PDF or CSV file.
Details: Displays or hides a window on the right-hand side with the optimization details of the project.
Filter: Allows to only show certain elements, e.g. only optimized or only non-optimized elements.
Rating History: Displays or hides a diagram with the project's rating history.
In this way, you can work through the list of optimization elements step by step and take all measures necessary in order to achieve a better ranking
among the selected search engines for the selected search term. Additionally, it provides you with an overview of the elements of your websites that are
already well optimized and therefore do not necessitate any changes.

3. Report
In this tab you can use Templates to customize the generated report and export or print it.
Generate: Draws up the analysis report.
Export: With this function you may export the analysis report, e.g. into a PDF or CSV file.
Report Settings: Use this button in order to only take certain elements (e.g. only optimized elements) into your report or to exclude certain
elements from the report.
Print Preview: By clicking onto this button, you can see how the analysis report will look like once printed.

History: Via this button you can look at already generated reports listed by their date, in order to compare report results.

Report Settings
Various aspects of the analysis report can be customized.
In order to edit the report settings, click on Analysis >> Analysis Report >> Report >> Report Settings.
In the opening window you can configure the following:
1. General
Include in Report: Select the sections that should be included in the report.
Chart Settings: Select a color for the chart. You can also define a custom color.
2. Content
Element: Below, you can manually check/uncheck all the elements or sections you want to have or not have in your report.
Move Up/Down: Furthermore, you can change the order of the elements in the list using the arrow buttons pointing upwards and downwards.

Website Rating
The Website Rating module in Hello Engines! provides an overview of the most important factors for a website in relation to its ranking.
As there are many different criteria to be considered for the ranking, promotion and popularity of a website you should check from time to time how well
the most important of those criteria like technical requirements, linking and an acceptable Page Rank have been fulfilled.
Note: The Rating module offers the possibility to check the most important criteria at a glance and calculates an overall rating for a website. Please
note that it should only be seen as a guideline and does not mean a representative statement about the quality or the real value of your website. With
the help of the rating you can identify which points may need to be improved and measure the changes over a specific period.
The Website Rating module consists of three tabs:
Website-Rating
Compare Websites: In this tab you can compare the results of different websites to each other.
Top 1000 Websites: This tab will show you the best 1,000 websites which were tested in ASEOPS and Hello Engines! for comparison.

Rating - Website Rating
In order to process a rating query, proceed as follows:
Website: Enter a URL here.
Rate Website: Click on this button in order to start the rating query. The query may take several minutes.
Export: With the help of this function, you may export the query results into different formats.
After the query is completed, you will receive the following information:
Overall Rating of the Website: Here you see the complete rating of the indicated website, with 100 being the best possible value.
Site Rank Position: Shows you the website’s position in relation to the 1000 best websites, e.g. place 678 of 1000.
Top 1000 Websites: Via this link, you may have a look at the dynamic list of the top 1000 entered websites. Alternatively, you can go to the
tab Top 1000 Websites which you will also find in the Website Rating section.
Last Update: Shows the date of the last update of this value.
In the field below, you will see the details which make up the rating. They are divided into four sections:
Site Rank: Hello Engines! determines how good your website is rated by important search engines and directories, for example the Google
PageRank. In addition, the age of the website is determined which also plays a role for a good ranking.
Site Popularity: This section is about the number of external links which different search engines determine.
Technical Analysis: Hello Engines! checks your websites for technical aspects which might be a problem for search engines, for example
Frames, and checks if the source code of the website contains any errors.
Social Bookmarking: Some websites offer the possibility for a user to refer to other good websites and this kind of recommendation is
becoming more and more popular today. Therefore, this section checks how many of the most important and best known social bookmarks the
website in question already has.
For each factor which contributes to the rating you will receive an overall value for the website. The criteria have different weights. Apart from this value,
you are shown in brackets which percentage of the possible score was achieved. At Component Rating, the scores for each section are summarized.

Rating - Compare Websites
You'll find the Compare Websites function in the Website Rating module.
This tool allows you to compare three websites regarding their optimization status. Thus you can, for example, compare your own website to that of your
best competitors.
In order to compare URLs, proceed as follows:

1. Enter at least two URLs into the fields URL #1-3.
2. Then click on Compare.
3. Once the comparison is finished, you will see its results below: in the upper half the all-in-all rating for each website, in the lower half the
websites' detailed results.
In addition to comparing websites, the present Compare Websites tab provides the following options:
Print Preview: Lets you see how the website comparison will look like once printed.
Print: Enables you to print the present comparison.
Export: Allows you to export the comparison's results into an HTML or PDF file.

Rating - Top 1000 Websites
You'll find the Top 1000 Websites in the Website Rating module.
In this tab, you can have a look at the best 1,000 websites which have so far been tested in Hello Engines!.
In addition you can also see, which rating they received (in comparison to your own website project) and when they were tested.
At the bottom of the page you can navigate the according position ranges (1-100, 101-200 etc).

Optimization
In the Optimization section, you can analyze your websites in regard to SEO and compare it to your competitor sites.
It contains the following modules:
SEO Analyzer
Optimization Report
Compare Documents (from Hello Engines! Professional)
Top 10 Compare (from Hello Engines! Professional)
Note: Please use the SEO Analyzer first to receive a list of all available documents and keywords, before using the comparison tools.

SEO Analyzer
You'll find the SEO Analyzer module in the Optimization section.
The SEO Analyzer provides the following functions:
Start Analysis: Click here to start the SEO analysis of your website. Hello Engines! will retrieve all the necessary data from and about your
website. To stop the SEO analysis, click Cancel.
Custom Analysis: If you would like to define your website's analysis more precisely, click on the lower half of the Start Analysis button and
then on Custom Analysis. In the opening window you can enter a different URL and configure the analysis' settings (e.g. its scan depth).
Reset Keywords: This option resets the keywords for the present URL. During this process, the inserted keywords are deleted for all
documents. Afterwards, the values from the meta tag "Keywords" are reinserted.
Export: Enables to export the SEO analysis into an HTML document.
Open URL: Opens the URL of the entered website.
Edit HTML: Allows to modify the URL's HTML document.
Once the analysis is completed, a list will appear below, specifying which optimization areas are already good and which need to be improved.
SEO Analysis: Checks if items like a title tag and headers are used correctly in your website and if the chosen keywords are found in different
parts of the website, like in the body or in the <alt> tags of images
Page Source: Shows the HTML source code of the selected site
Page Preview: Shows a preview of the appropriate site in the browser
Clicking the + icon will display the subpages of the website and their rating and analysis.
Note: You can define different keywords on which the analysis is based for each page of your website project. To do so, select a page and change or
add keywords in the Page Keywords section on the right. You can also add keywords from a list which you have created in the Keywords section by
clicking Load from template.
Finally, you have two possibilities:
In order to export your report or print its results, go to the SEO Report section.
In order to customize your report, select a template you previously created in the Templates section.

SEO Report
The SEO Report is based on the results of the SEO Analyzer. It allows you to create a well-structuted report listing all the SEO ratings for the pages of
your domain.
In this section, you have following options:
Generate: Click here in order to generate a SEO report and to show changes you may have applied to the template.
Export: You can export the report into HTML, PDF, CSV, MS Excel or Word.
Template: Select a template which you have created in the Templates section from the list.
Print Preview: Lets you see what the SEO report will look like once printed.
Print: Enables you to print the present SEO report so that you can compare the values after the optimization.
History: Clicking this button allows you to view a window on the right hand side which displays the dates of SEO reports.

Compare Documents
In the Compare Documents module from the Optimization section, you can compare two of your domain's pages or any other URL to each other in
regard to their SEO optimization for a specified keyword.
The home page of your project is already preselected as the first URL, but you can easily select a different page from the drop down list.
Note: Please note that you should do a SEO analysis first to get a list of the available documents on the domain.
Enter a second URL into the field Compare to or select one from the list.
Below, you can enter keywords manually. By default, the keywords specified for the page in the SEO Analyzer module (normally the keywords from the
keywords meta tag) are used here as well.
Click Compare to start the analysis process.
You will then receive a list with the SEO analysis elements for both pages and can compare them accordingly.
At the top you will see the overall rating of both websites.
You can export the results of the Compare Documents module on the right side of the toolbar to HTML or print them. Select a Template created in the
Templates section to use your own logo and formatting, then click Generate to apply the changes.

Top 10 Compare
The Top 10 Compare module from the Optimization section allows you to compare your own website's SEO rating to those of the top 10 competitors for
a keyword.
First of all, select the URL from your own domain to which you would like to compare the competitor websites. Below, you can select the keyword and the
search engine which will be used to determine the top 10 competitors. By default, you will find the keywords you have selected for the page in the SEO
Analyzer in this list, but you can also type in a different keyword.
Then click Analyze Top 10 and Hello Engines! will determine the top 10 competitors for the keyword and do a SEO analysis for them.
On the left side of the results table, you will find all the elements which were tested. Thus, you can see at a glance how your website and the top 10
websites are rated for each element and can determine where your competitor websites' strength and weakness regarding SEO lie.
Note: The percentage which is given is always a rating which shows how well a website does in regard to this element. For example, a rating of 100%
for duplicated meta tags does NOT mean that there are duplicated meta tags everywhere, but that there are no duplicated meta tags and thus the
websites receives a 100% rating for not having duplicated meta tags. For a more detailed analysis of a single website, use the SEO Analyzer.
You can use the Export button to save the results of this comparison.

Keywords (from Hello Engines! Professional)
The Keywords section assists you in creating keywords and keyword lists that you can use in directories or for ranking queries in Hello Engines!.
This module has two sections:
Keyword Analyzer
Keyword Tools

Keyword Analyzer
The Keyword Analyzer section allows you to create and edit keyword lists.
Click on New to create a new keyword list. As a first step, choose a name for your list. Confirm with OK. This list is then displayed as the active list. Using
the corresponding button you can Rename or Delete the selected list.
Click on Add Keywords to add new keywords to the active list.
Furthermore, you can load keywords from a text file by clicking the button Load from File....
To add the content of the clipboard to your keywords choose Paste from Clipboard.
Another possibility is to import keywords from an URL by clicking Load from URL.... Enter the URL from which the keywords are to be extracted and
confirm with OK.
The generated keyword list can be saved as a text file.
By clicking the button Properties or by double-clicking on a certain keyword you can see more details about it. Select a Search Service and the number
of Top URLs to see the details, for example your top competitors, for the selected keyword after clicking Analyze. Via Analyze All all keywords which are
currently in the list will be analyzed accordingly.
Tip: If you select a competitor URL for a keyword in the list, you can right-click it to create a new project for this URL or to analyze it for further
investigation.
In addition, you can delete one or more keywords from the list or directly rename them in the list.

Keyword Tools
In the Keyword Tools section different tools are available to analyze keywords and generate new ones.
In the main window you will see the keywords that belong to your currently selected active keyword list.
Mark an item in the keywords list - or more than one by holding CTRL pressed - this will determine which search service you would like to query and how
many results you would like to receive. You can click Analyze to see more details about a keyword. Alternatively, you can analyze all keywords at once.
You can see the Properties of a keyword by double-clicking on it in the list.
Using the button Suggest you can generate new keywords based on one keyword to start with.
Furthermore, you can use different Web Services to generate new keywords.
To analyze the websites of competitors in view of keywords, click Competitors.
You can generate combinations of different keywords by choosing the Combinations option.

Backlinks (from Hello Engines! Professional)
In the Backlinks section of Hello Engines!you can have a look at all the websites which link to yours and analyze them.
In the Backlinks List module you can search for links and manually add new links
In the Summary module you will get an overview of the distribution according to different criteria like PageRank and country of origin.

Backlinks List
The Backlinks List will help you to find and analyze external links to your website.
Click Retrieve Backlinks to start the query of links for the project URL.
Note: By clicking on the lower half of the Retrieve Backlinks button you can configure if the found links should be analyzed automatically. By
default this option is activated.
Note: By clicking on the lower half of the Retrieve Backlinks button you can set the number number of found/analyzed links. If there are duplicates
among the found links, you may receive slightly less links than set.
You can also add backlinks manually by clicking Add URL or Import (.txt or .csv files). If you select a backlink in the list, you can delete it.
Use the Analyze All button to analyze the whole list or the Analyze Selected button to analyze only a part.
The results table offers the following values:
URL: The URL of the website which contains a link to the URL you entered
Status: The HTML status of the URL, normally a 200 - OK
Target: The exact site of your domain to which the website links
Anchor text: The text with which the website links to your URL
Outbound Links: The number of outgoing links on the website in total
Attribute: Special characteristics of the website as for example nofollow links
IP address: The website's IP address to see if any of your backlinks come from the same IP.
PageRank: The Google PageRank of the website
Server location: The place where the server of the website is located
Domain: The domain to which the website belongs
Added on: The date when this backlink was first found or added
Page Authority: The Page Authority predicts how well a web page will rank in a domain. The higher the Page Authority, the greater the
potential to rank well
Page MozRank: The mozRank represents the importance of a domain and has a value between 0 and 10 attributed by SEOMoz.org to a web
page. The higher the value of the mozRank, the more important the document on a domain becomes.
Domain Authority: The Domain Authority predicts how well a web page will rank on a domain. The higher the Domain Authority, the greater
the potential for an individual page on that domain to rank well
Domain mozRank: The Domain mozRank represents the importance of a domain and has a value between 0 and 10 attributed by SEOMoz.org
to a web page. The higher the value of the mozRank, the more important the domain becomes.
You can have a closer look at one link by double-clicking it or by selecting it and clicking the Properties button in the toolbar. In addition, you can open
the website in your browser from here.
Via Find Backlink you can search for a particular backlink in the list.
In the Report tab you can create a report of all the backlinks which are currently in the list - for your records or for your customer. Alternatively, you can
export the link list into different formats like CSV or TXT.

Summary
In the Backlinks Summary module you will get an overview of all the backlinks which were found.
Note: This backlinks summary refers to the links found in the Links List section.
Under Statistics you will find information about the total number of backlinks found for the analyzed site and their distribution in regard to IP addresses,
NoFollow/Follow and unique domains.
The Page Rank Diagram shows the PageRank distribution among your backlinks. The links should be distributed naturally (as the PageRank increases, the
number of backlinks decreases). You can check this distribution in the backlinks pyramid (the number of backlinks should decrease from the bottom to the
top)..
The Domain Authority Diagram shows the Domain Authority distribution among your backlinks. It is important to note that Domain Authority is on a
100-point, logarithmic scale. Thus, it is much more difficult to increase your score from 70 to 80 than it would be to increase it from 20 to 30.
Below you see the distribution in regard to Geographical Origin, in other words the countries from which the links come.
The NoFollow Diagram shows the distribution of Follow and NoFollow links among your backlinks.
You can export all these backlinks statistics to different formats by clicking on Export in the toolbar.

Ranking (from Hello Engines! Professional)
The Ranking section helps you to determine where your website (or that of a competitor) is currently listed in a search engine for specific keywords or
keyword combinations.
It is divided into the following modules:
Query search engines
Ranking Status

Ranking Query
To see how your website is ranked by the different search engines, you can use the Query Search Engines module. Please proceed as follows:
1. Enter a URL into the Websites field. Click Add to add the according URL to the list. You can also load URLs from the clipboard or from a text
file.
2. Enter the keywords which you would like to query into the Keywords field. In addition, you can paste keywords from the clipboard or from a
list which you, for example, created in the Keywords section. Afterwards, click Add.
3. On the right-hand side you can select the search engines for the query.
4. If you want to change the number of ranking results, you can do that in the Advanced tab of the project Properties.
5. Click Start Query in the tool bar to start the process.
6. After the query was completed, you will automatically be referred to the Status Report section, where you will be shown the results.

Ranking Status
The Ranking Status module of the Ranking section displays the results of the Search Engines Query.

1. In the Table View you are shown a summary of the results. The URL column indicates the number of subpages in the top results. Click the +
icon to have a closer look at those subpages and their ranking.
On the right side you will see the Queries History which presents the results of previous queries. It can be displayed or hidden by clicking on Queries
History in the tool bar.
Below are the Query Details. Select a keyword and the corresponding search engine in the list of the main window to have a look at the development of
the results. Thus you can check what effects the changes you made to your website have had.
The Positions Chart displays the results over time graphically.
The ranking query results. can be exported by clicking on Export and selecting the desired format (PDF, CSV, MS Word, MS Excel).

2. You can then switch to the Report tab to save or print the results. You can customize your report by selecting a template which you have
previously created in the Templates section.

Tools
In the Tools section contains many useful tools for analyzing and editing your website (e.g. generating sitemap or meta tags).
Select one of the following tools:
HTML Validator
Link Validator (from Hello Engines! Personal)
Site Scanner (from Hello Engines! Professional)
Web Robot Simulator (from Hello Engines! Professional)
PageRank Calculator (from Hello Engines! Professional)
Site Map Generator
Robots Generator (from Hello Engines! Professional)
Load Time Checker (from Hello Engines! Professional)
Code Shrinker (from Hello Engines! Professional)
Metatag Generator
Automatic Submission (from Hello Engines! Personal)
Manual Submission (from Hello Engines! Personal)
Dublicate Content Finder (from Hello Engines! Professional)
Social Websites (from Hello Engines! Professional)

HTML Validator
The HTML Validator checks the source code of HTML documents for superfluous or wrong attributes and commands, automatically created, for example,
by some WYSIWYG editors (WYSIWYG = What You See Is What You Get). They affect loading time, especially in bigger documents, or even cause mistakes
on the site.
The HTML Validator has two tabs: Pages List and Report.

1. Pages List
The Pages List tab provides following buttons:
Start Analysis: Click here to analyse the URL of a project and its subpages. The time needed for the analysis depends on the complexity of
your site and the speed of your connection.
Custom Analysis: By clicking onto the lower part of the Start Analysis button, you may do a custom scan. In the Custom Scan dialog, you
can e.g. select a scan depth and thereby determine to which level Hello Engines! will follow links on your site. Additionally, you can increase
or decrease the number of threads to increase or decrease the query speed. Finally, you can exempt certain pages, folders and session IDs from
the analysis.
Properties: If you would like to see all details on a certain Web page, choose this page and then click onto the Properties button.
Alternatively, you can double-click onto the respective page in the list.
Correct Error: Allows fixing mistakes on the website.
Open URL: Opens the indicated website in your browser.
Find URL: Enables you to search the URLs shown in the list for a certain term that you enter into this function’s search mask.
Copy URL: Copies the selected URL to the clipboard.
Export: Exports the data you have received into different formats
View HTML: A click onto this button shows or hides the HTML source code of the selected URL in the lower part of the current window. You
open and edit the pages directly in the HTML Editor if you configured the access to the source files in the project's Properties.
Once the analysis is completed, the main window shows the errors and warnings regarding the indicated website. In order to see details about these errors
and warnings, click onto the + icon in front of a webpage.

2. Report
Via the Report tab, you can create a report of the HTML validation process. Afterwards, you will be able to compare this report with reports you will
generate once you have optimized your website.
The Report tab offers the following options:
Generate: Click here in order to generate a report of the HTML validation process.
Export: You can export the report into different formats.
Template: Select a template which you have created in the Templates section.
Print Preview: Lets you see how the validation report will look like once printed.
Print: Enables you to print the present validation report so that you can compare the current values to those after the optimization.
History: A click onto this buttons shows a window at the right hand side which displays the dates of previously generated reports.

Link Validator
The Link Validator from the Tools section helps you finding links on your website which don't work (anymore).
The Link Validator has two tabs: Link Validator and Report.

1. Link Validator
In the Link Validator tab you will find the following buttons:
Start Analysis: Click here to analyse the URL of a project and its subpages. The time needed for the analysis depends on the complexity of
your site and the speed of your connection.
Custom Analysis: By clicking onto the lower part of the Start Analysis button, you may do a custom scan. In the Custom Scan dialog, you
can e.g. select a scan depth and thereby determine to which level Hello Engines! will follow links on your site. Additionally, you can increase
or decrease the number of threads to increase or decrease the query speed. Finally, you can exempt certain pages, folders and session IDs from
the analysis.
Properties: If you would like to see all details on a certain Web page, choose this page and then click onto the Properties button.
Alternatively, you can double-click onto the respective page in the list.
Correct Error: Allows fixing mistakes on the website.
Open URL: Opens the indicated website in your browser.
Find URL: Enables you to search the URLs shown in the list for a certain term that you enter into this function’s search mask.
Copy URL: Copies the selected URL to the clipboard.
Export: Exports the data you have received into different formats
View HTML: A click onto this button shows or hides the HTML source code of the selected URL in the lower part of the current window. You
open and edit the pages directly in the HTML Editor if you configured the access to the source files in the project's Properties.
Once the analysis is completed, the main window shows the errors and warnings regarding the indicated website. In order to see details about these errors
and warnings, click onto the + icon front of a webpage.
You can find those links which no longer work in the list by their Status. In addition, you can have a look at the titel, type, size and modification date of
each linked page.

2. Report
Via the Report tab, you can create a report of the HTML validation process. Afterwards, you will be able to compare this report with reports you will
generate once you have optimized your website.
in the Report tab you will find the following buttons:
Generate: Click here in order to generate a report of the HTML validation process.
Export: You can export the report into different formats.
Template: Select a template which you have created in the Templates module.
Print Preview: Lets you see how the validation report will look like once printed.
Print: Enables you to print the present validation report so that you can compare the current values to those after the optimization.
History: A click onto this buttons shows a window at the right hand side which displays the dates of previously generated reports.

Site Scanner
Use the Site Scanner to read all links and HTML documents of a site. This can be useful when you e.g. want to clean your web server and quickly
determine unused documents.
To use the Site Scanner, select it from the Tools section, and proceed as follows:
Click Start Analysis to start the reading process. The amount of time needed depends on the complexity of your site and the speed of your connection.
Click the lower half of the Start Analysis button to do a custom scan. In the Custom Scan dialog, you can select a Scan Depth to determine to which
level Hello Engines! is going to follow links on your site and increase/decrease the number of Threads to increase/decrease the query speed. In addition,
you can skip certain pages, folders and session IDs and external links.
When the scan has finished, all found links are displayed.
After scanning your site you can have a closer look at each link by selecting it from the list and clicking Properties.
You can Export the list of websites to different formats or create a report in the Report tab.

Site Scanner - Properties
The dialog window Properties shows the properties of a selected link. This window may be called up when using e.g. the HTML Validator.
The Properties window consists of three tabs:

1. General
In this tab you find the following information:
The title of the selected website.
The description entered for this site.
Robots: the site’s indexing, e.g. "index" or "follow."
Modified: the date of the site’s last modification.

2. Outbound Links
Offers information about links leaving the site.

3. Inbound Links
Offers information about the links leading to this site.

Web Robot Simulator
The Web Robot Simulator shows you how search engine robots "see" your site and that of your competitors.

1. Select an agent to see the URL through his eyes.
2. Enter the URL you would like to analyze into the address bar. Open the URL by clicking on Navigate or by pressing ENTER.
3. On the left you see the website as it is displayed in a common browser. On the right you can switch between five different views:
Robot View: This view will show you what and how search engines read your site.
HTML Source: Shows the source code of the currently open website
Content: Subdivides the content of each area like title, meta tags and body and shows you the mere text content only
Keywords: A graph which demonstrates how often each keyword is used in the text
Links: Lists all links outgoing from this site with their link text and possible nofollow attributes

PageRank Calculator
The Page Rank Calculator helps you find out how the internal linking of your website affects the PageRank distribution.
Thus, you will receive important information about the question if you give most PageRank to your important documents by internal linking or if you "waste"
it on unimportant ones.
For calculating the program will use a PageRank of 1 as default. After analyzing your linking you will be able to see what the new PageRank would look like
based on the fictional starting PageRank 1.
Note: This module analyzes the internal linking and the resulting distribution of the PageRank given by Google, but it does not analyze the external
linking or the actual PageRank.
Click Start Analysis to start the reading process. The amount of time needed depends on the complexity of your site and the speed of your connection.
Click the lower half of the Start Analysis button to do a custom scan. In the Custom Scan dialog, you can select a Scan Depth to determine to which
level Hello Engines! is going to follow links on your site and increase/decrease the number of Threads to increase/decrease the query speed. In addition,
you can skip certain pages, folders and session IDs.
Depending on how extensive your website is, the analysis may take some time.
Afterwards, you will be shown all important information in tables.
After a successful analysis the upper table will show all documents of your website.
URL: The exact URL of this document.
Status: The http status code received.
Title: The documents title according to the Title Tag
PageRank: The determined PageRank based on a starting value of 1.
Inbound Links: The number of links which link from other documents of your website to this document (links from external websites are
ignored).
Outbound Links: The number of links which link from this document to other documents of your website (links to external websites are
ignored).
Click on a row in the upper table to see in the other two tables below which documents are linked and where links come from.
Tip: You should aim at getting the highest PageRank especially for all those important documents which you have optimized for certain keywords and
with which you would like to achieve a good ranking.
You can export the list of websites to different formats or create a report in the Report tab.

Sitemap Generator
Use the Sitemap Generator from the Tools section in order to organize your website and to make sure that all pages are found by search engines. This is
particularly important when your website was built using Flash or Java Script menus that do not include HTML links.
There are two ways to create a sitemap:
1. Automatic Site Scan
Click on Start Analysis to scan your website.
Via the arrow in the lower half of the button Start Analysis, you can launch a custom analysis. For this you with the following options:
URL: Define a different URL.
Scan Depth: Determine the scan depth for the indicated URL.
Max. Number of Pages: Limit the number of pages to be analyzed.
Default Page: Set the usual homepage, e.g. index.htm.
Scan Sub-domains: Determine whether sub-domains shall also be analyzed.
Skip URLS/Folders: Exclude certain website addresses and/or folders from the analysis.
Clean Session IDs: Deletes temporary session IDs.
Check External Links: Determine whether external links – i.e. links to outside, additional contents – shall also be checked.
The analysis’ result will be shown in the main window. It contains information about e.g. URL, title, description, size and importance.
2. Manual Creation
The second possibility to create a sitemap, is to add the links manually. Choose this option if you would like to manually Add Pages or Import the links
from a file (XML or TXT).

When there are some links in the list, the following buttons become available in both tabs:
Generate: Via this function you will get a sitemap in HTML and XML format. The HTML Site Map tab generates a website "map" in HTML
format for human visitors. The Sitemap XML Index tab provides a XML sitemap for the indexing by search engines.
Sort: You may change the sort order of the single elements by choosing Ascending or Descending.
Save As: Save the sitemap for further use.
Customize: Here you can specify the settings of your sitemap.
Open in Browser: Shows the analysis’ result in the browser.
Default Change Frequency: Select a change frequency in order to set the update rate for the specified URL.
Default Priority: Determine the indicated URL's priority in relation to other pages on the same site. This setting can help the Google robots to
crawl the website correctly.
Default Last Modified: Choose e.g. the server response or a certain value.

Customize Sitemap
There are several settings available to customize your sitemap:
General Options
Use Relative URLs
External HTML Template: Use a HTML template to change your sitemap's design.
External CSS Sheet: Use a CSS Sheet to change your sitemap's design.
Display elements: Select the elements to be displayed in the sitemap (Page Title, Description, URL, Content Sample).
Include in HREF Elements: Select the elements to be added to HREF (Page Title, Description, URL, Content Sample).

Robots Generator
Robots are used by search engines to index the web.
The Robots Generator helps you create a robots.text file to exclude certain robots or disallows access to specified folders of your website. This file must be
copied to the root directory of your domain. You will find the Robots Generator in the Tools section.
How the robots.txt works:
To determine Use User-agent: Name of the Robot you determine for which search engine robot the orders are valid. By adding Disallow entries you can
determine folders which you don't want to be indexed, for example, because they have not yet been finished. In addition, you can add comments for
yourself which are identified by an # and ignored by robots.
To address all robots, use the * character.
To create a completely New File, click the according button in the toolbar, otherwise click Open File.
Click New to add Robots Exclusions and the path to your sitemap. By clicking Edit you can make changes to the existing entries.
Tipp: Use the Site Scanner to read the structure of your site and select directories to be locked for selected agents.
Below the list of User Agents and Disallow paths you can see the source text of your robots.txt file. Click Refresh to apply any changes you made in the
upper part to that text or vice versa.
When finished you can Save your file or Export its content to a text file.

Robots Element Editor
In the Robots Element Editor you can put together all the elements you need for your robots.txt file.
As Element Type, you can select
Robots Exclusion: Use this element to exclude specific or all robots from certain directories of your website.
Sitemap: Use this element to enter the path where your sitemap is located, so that robots can easily find it.
Comment: Add your own comments here which will be ignored by the robots.
When you select Robots Exclusion, you can add robots and Disallow paths by clicking the according button on the right.
To add robots, you can select either all robots by selecting the * character or specific ones from the drop down list. For adding disallow paths, simply enter
the directory which you want to exclude.
Of course, you can also edit or delete elements from the list.
In the end, a Robots exclusion might for example look like this:
User-agent: *
Disallow: /temp/
This would mean that all robots are not allowed to index the /temp/ directory of your website.
To specify the location of your Sitemap, enter its URL into the according field and optionally a comment as well.
To add any personal comments about the whole robots.txt, select the element type Comments and enter your text.

Load Time Checker
The Load Time Checker uses file and image sizes to determine the average loading time of a site with different speeds.
Click Start Analysis to start the reading process. The amount of time needed depends on the complexity of your site and the speed of your connection.
Click the lower half of the Start Analysis button to do a custom scan. In the Custom Scan dialog, you can select a Scan Depth to determine to which
level Hello Engines! is going to follow links on your site and increase/decrease the number of Threads to increase/decrease the query speed. In addition,
you can skip certain pages, folders and session IDs.
The results are displayed in the main window, split into different sorts of Internet connections. Click the + icon to have a closer look at the elements of a
site and their loading time to determine which of them possibly cause a higher load time. To see all details about a specific subsite at a glance, select it and
click Properties in the tool bar.
To create a report with the results of the Load Time Checker, click Create in the toolbar after the scan was completed or switch to the Report tab. Of
course, you can Edit, Print and Save (as HTML, MHT or TXT file) your report, so that you are able to compare the current results to the ones you will have
after optimizing your website. Via the Export button you can also save your results in different formats or create a report via the Report tab.

Code Shrinker
The Code Shrinker simplifies HTML code, so that better loading times are achieved due to smaller files. Like the HTML Validator, it deletes unnecessary
HTML code.
Click Start Analysis to start the reading process. The amount of time needed depends on the complexity of your site and the speed of your connection.
Click the lower half of the Start Analysis button to do a custom scan. In the Custom Scan dialog, you can select a Scan Depth to determine to which
level Hello Engines! is going to follow links on your site and increase/decrease the number of Threads to increase/decrease the query speed. In addition,
you can skip certain pages, folders and session IDs.
After reading and compressing the files, the compression report is displayed in the main window.
You can select a compressed file from the compression report and take a look at it using the Open URL button on the right side of the tool bar. The
compressed files can be saved individually or all together via Save .
Via the Export button you can also save your results in different formats or create a report via the Report tab.

Metatag Generator
Meta tags help robots index each document of your website correctly. Every single page of your site should have individual meta tags referring to the
respective content of that page.
The Metatag Generator helps you create meta tags fast and easily.

1. Standard Tags
Enter a value for each meta tag.
New: You can start a different meta tag project
Open: Allows you to open a metag tag project you already created before.
Import: Read existing meta tags from existing HTML files or from an online URL and to edit or insert them into other documents.
You will find more information about the different meta tag types in the Meta Tags topic.
Tip: Import an existing HTML file to check whether it contains valid meta tags.
When you are ready, open the Generate tab.

2. Generate
The list contains all meta tags you filled in previously. Uncheck any item that you don't want to use in your current document.
Then, click Generate to create the correct code. It is shown in the Results section.
By using the Copy to clipboard button you can copy the generated meta tags and paste them into a HTML document. If you select As HTML page the
correct tags
<html>
<head>
</head>
<body></body>
</html>
are directly created and copied as well.
Alternatively, you can add your meta tags to a HTML document by opening the Insert tab.

3. Insert
Click Add file to select a HTML file, into which you would like to insert the generated meta tags. Via Add folder you can add all files within a specific folder
to the list.
Next click Insert to insert all created meta tags into the selected files.
The Edit HTML button will open the HTML document directly in the HTML Editor.

Automatic submission
In the Automatic Submission tab of the Tools section you find all search services that support this kind of submission in Hello Engines!.
First of all, please select an existing Template with submission data or click New Template to create a new one. You can change the selected template
any time by clicking Edit Template.
The search engines are sorted by country what makes it easy to find the right ones.
To select the desired search engines, click the + icon next to the according country to see all available search services. The Rating and the PageRank
which are shown for a search service will help you to get an idea about their importance. In addition, the Language is listed for all search services. If you
would like to include all search services which are available for a country, simply check the box for that country instead of selecting them individually.
Note: Some of the listed search engines have restrictions and only accept certain top level domains like .com or .de. If this is the case, this is shown in
the Restriction column and you can only submit your site if your website meets this condition.
If you have previously done an analysis with Hello Engines! the program has already analyzed in which search services you are already listed and in which
not. This can be seen in the Recommendation for every search service. To submit your website only to those search services where you are not listed yet,
click the Select button and choose the option Recommended only. Thus, only missing search services are checked. In addition, you can use the Select
button to check all search services at once or to uncheck them all. To see only those search engines which are currently checked, you can click the Show
Selection button. Click it once more to see all search services again.
Then click Submit in the toolbar to do the submission to all selected search engines.
After submission, you can directly see if the submission to a selected search service was successful by looking at the Status which is shown in the list.
Below, you will also be shown the answer page which the search service returned.
Note: The status OK 200 does not mean that your website has already been added to the search service! This may take some days or even weeks.
The status will only inform you if the submission was successfully received by a search service.
The date of the submission will be added to that list so that you can later see at a glance when you last submitted to a specific search service.
Via the Export button you can save your results in different formats or create a report via the Report tab.

Manual submission
The Manual Submission tab comprises all search engines or directories which do either not allow automatic submission or which have e.g. premium offers
about which you should decide yourself.
First of all, please select an existing Template with submission data or click New Template to create one now. You can change the selected template any
time by clicking Edit Template.
On the right side, you see a list of all search services sorted by country. Click the + icon to expand the view and see all search services for a certain
country.
The Rating and PageRank will help you to estimate the importance of a search service. In the Recommendation field you will find information whether
you should submit your website to that search engine or directory, based on the results of the analysis which Hello Engines! made.
As soon as you select a search service in the list, the website of that search service will be opened in the browser on the left side.
In most cases this will already be the site where you can submit your side, in some cases you may need to do some clicks to reach the correct page,
because you need to decide between premium and free offers.
With the Back and Forward buttons you can go to a previous or already opened site as in any browser.
In the Fields section on the right, you see all the information which you have added in your project. By clicking the Fill Form button in the toolbar, Hello
Engines! will fill this information into the submission form of the website. You can change, add and review the entries, if necessary.
To erase all entries in the form click Clear Form.
If you already submitted your site to a search service or do not want to do so, you can mark it as submitted by clicking the according button in the
toolbar. Thus the recommendation for the selected search service will change. Accordingly, you can mark it as not submitted.
After filling in all necessary fields, you can submit your site by clicking the according submit field in the submit form.
Via the Export button you can save your results in different formats or create a report via the Report tab.

Duplicate Content Finder
With the help of the Duplicate Content Finder you can search your website for texts which are used on several sites ("Duplicate Content") to avoid that
some contents and subpages are evaluated more negatively or are not indexed by Google. Make sure that every subpage has its own, unique content.
Note: It is, of course, not possible to avoid all kinds of overlapping in one website project. Even the use of the same always used navigation bar can
lead to a certain grade of concordance. Therefore, you should concentrate on the text contents and avoid sites which are 90 or 100% identical in
regard to content.
If you want to analyze your project URL and its subpages, click Start Analysis. Otherwise, click the lower half of the Start Analysis button to do a
custom scan. In the Custom Scan dialog, you can select a Scan Depth to determine to which level Hello Engines! is going to follow links on your site
and increase/decrease the number of Threads to increase/decrease the query speed. In addition, you can skip certain pages, folders and session IDs.
After the scan finishes, you will be shown a matrix of all the pages in the main window which allows you to compare every site in your domain with every
other site. You get a percentage for every pair of pages, which will show the level of similarity.
You should look for pairs of websites which show a higher number of similarity, for example 70 or 90%. These fields will be marked in colors (yellow and
orange). If you click such a field, you can compare the Original Page to the Similar Page below.
You can export the results of the Duplicate Content Finder to .csv or an Excel spreadsheet by clicking Export in the toolbar. In addition, you can create a
Report on the according tab which will list all similar web pages.

Social Bookmarks Manager
With the Social Bookmarks Manager you can manage your existing social bookmark accounts like De.licio.us in one single application.

Favorites
This area consists of three tabs:

1. Accounts
The accounts you saved in Hello Engines! are listed here. Clicking on an account will open its login page in Hello Engines! and fill in the saved login
information automatically.
Through the context menu you can open an account's Properties where you can edit the login information and URL.

2. Recommended
Provides a list of social websites recommended by Hello Engines!.

3. History
Displays Hello Engines!'s browser history.

Reports & Success Tracking
In the Reports section you have the possibility to combine the results of the different analyses and tools in one General Report.
The reports for the different tools and analysis functions can be generated in the according sections in the program.

General Report
In the General Report module you can combine the reports of different modules into one overall report.
To do this, select the items you want to add from the Report Builder on the left side and click > to add it to the selected reports on the right.
Alternatively, you can select an element, right-click it and choose Add to Report. Through the context menu > Display you can have a look at the
according report.
To remove an item from the report, select it and click < or right-click it and select Remove from Report. Through drag&drop (or over the context menu)
you can also change the order of the elements.
Afterwards, click Generate to create the report with the items you chose.
When you are ready, you can Export or Print the general report.

Task Planner (from Hello Engines! Professional)
You can schedule automatic analyses, ranking queries and submissions by using the Task Planer. Hello Engines! doesn’t need to run in order for the
Planer to work.

Starting the Task Planer
Double click the file aseops_tp.exe from the Hello Engines! installation directory.
TIP: Configure the Task Planer’s Options to start together with Windows; the tasks will run even if Hello Engines! is not started.

Adding a new task
In order to add a new task click on Task >> New Task or hit the shortcut key combination CTRL + N. Add the desired project(s) by clicking on Add and
configure
the task afterwards in the Task Properties dialog.

Manage tasks
You can access and modify a task’s Properties at any time through the context menu, by right-clicking on the task. You can also start, stop or delete a
task over the context menu.

Log
You can always check if a task was completed successfully or if there was an error in the Status column of the Task Planer main window. More detailed
information can be found in the Results tab from the task Properties.
Alternatively to the Task Planer you can create a batch file with the following
command:
<path>helloengines9.exe -<command> -<list>
<path> = path to the ASEOPS 9 installation directory
<command> = analysis, ranking or submission
<list> = fully qualified name of the plain text file with the name of the project filenames (*.sit).

Program Options
The program options of Hello Engines! can be opened via the according entry in the Edit menu or by clicking F11. They are divided into eight tabs:
General
Projects
Advanced
Network
Custom Ratings
Backlinks
Sound
Proxy Servers
You can reset the default settings by clicking on Restore default settings in the lower left corner.

Options - General
In the General tab of the Hello Engines! program options you can decide on the following settings:
User Interface Language: Select the language you want to use.
User interface theme: Change the program's appearance.
Open last project at startup: If you check this option the last project will be opened once you restart the program. This is useful if you are
working with one project at a time.
Auto-run Quick Rating after website analysis: Check this option if you want to receive a percentage result for your website after using the
Website Analysis module
Automatically check for updates every x days: If you check this option, Hello Engines! will detect updates of the program or the
database automatically.

Options - Projects
Your projects will be saved in this location. You can use the Change button and define another storage location (e.g. a network folder to share your projects
with other team members).

Options - Advanced
This tab has three areas:
1. Analysis Settings
Max. Threads: Set a number of threads which will be used for queries as a maximum. A larger number will increase the speed.
HTTP Timeout: A specified period of time that will be allowed to elapse before an error is returned.
Ignore characters in keywords: Enter the desired characters without any delimiter between them.
2. Ranking Settings
Here you can adjust the settings for search engine queries. You can use these settings to make the queries more search engine-friendly so that you don't
get blocked.
Visit search engine query before query: Loads the search engine's main page first (e.g. google.com ).
Random pause after homepage: Hello Engines! will use a value within these specifications to wait before starting a query.
Random pause between queries: Hello Engines! will use a value within these specifications to wait before starting a new query.
User-Agent string: Select the default user-agent string.

3. Web Files
Select which file types are to be analyzed by the Site Checker modules, like e.g. Link Checker, HTML Validator etc. If your page includes HTML files
with any extensions which are not listed you can them here so that Hello Engines! recognizes these files as well. Simply enter it into the field below and
click Add.

Options - Network
If you are using a proxy server, you need to configure Hello Engines! so that it can connect to the Internet via HTTP and FTP.
In most cases, no changes need to be made as most Internet connections work without proxy servers.
Tip: If you are not sure whether you are using a proxy server, click the System Settings button. If your computer is configured correctly, proper
settings will be used automatically, and no further changes need to be made.
Make sure you enter your proxy settings into the right section (FTP vs. HTML). If necessary enter a user name and password as well. (This section should
only be changed by advanced users. If in doubt, contact your system administrator.)

Options - Ratings
On the Ratings tab of the program options you can change the importance and weight for the different SEO criteria which are used in the Website Analysis
section. This way you will be able to decrease the weight of a certain element in case you consider it to be less important for your projects.
Select an element from the list and set its importance and weight on the right side. You can select an Importance (less important, important, very
important) from the drop down list and change the Weight by moving the scroll bar.

Options - Backlinks
In the Backlinks tab, you can choose how your backlinks will be selected. You can pick either SEOmox Top-1000 URLs or blekko SEO Tools. Blekko's
web service requires you to sign up free of charge. Simply click on the provided link.
TIP: Backlinks from Google Webmaster Tools can be imported as well. When a project is open, go to the Backlinks List and click on the lower part of
the Retrieve Backlinks button.

Options - Sound
On the Sound tab, you can configure individual sounds for specific program events. First, select the program from the event list and then assign it to the
desired sound.
Press the Browse button to get to additional sounds on your computer, which you can assign to program events.

Options - Proxy Servers
Use these Option to create a list of proxy servers in order to accelerate large search engine queries. In order to use this feature you need to check Use
proxy servers for search engine query.
You can either type in the proxy or load a list from a text file.

Lost Unlock Key Wizard
The Lost Unlock Key Wizard assists you in recovering your unlock key, in case that you lost it. Open the Tools menu and click on Lost Unlock Key
Wizard.
In the first step of the wizard you are asked for some relevant data, which the AceBIT service team needs to be able to find your lost unlock key (bold fields
are required):
First name: Enter your first name.
Last name: Enter your last name.
Company: Enter your company unless you do not use the program privately .
Email address: Enter the email address you used when ordering the product. If you are not unsure, you can enter more than one email address by
separating them with a semicolon (";").
Reseller: Select the seller from which you bought the product, e.g. 1&1. If you have forgotten, select Don't remember. If you select Other Online Shop,
you can specify it in the text field on the right.
Purchase date: Enter, when you bought Hello Engines!. If you are unsure, enter the approximate date.
Comments: Here you can add further details for the AceBIT service team.
Click Next after filling in all required fields.
As a next step you are asked to review the details which you are going to send to AceBIT. If you would like to make any changes, click Back, otherwise
click Finish to send the request using your default email client.

Test Connection Wizard
The Test Connection Wizard will connect to one of the AceBIT servers to test the connection. If the attempt fails, the log will help to find the reasons for
the problems.
Open the Tools menu and click on Test Connection Wizard.
Note: Please ensure that to access the internet is allowed to Hello Engines! by your firewall.
Under Proxy you can enter proxy settings if you are using a proxy server. If you are not sure, click System settings and Hello Engines! will use the
settings that Windows uses.
Click Next to start the connection test .
If any problems should occur, the log which is generated will help to resolve the problem. In such a case, please review the text which is sent to AceBIT
and click Finish to send the log using your default email client.

Report Search Engine Wizard
To report a search engine which you would like to have added to the database of Hello Engines!, open the Tools menu and click on Report Search
Engine Wizard.
Fill in as many fields as possible with information on the search engine you want to report. Fields in bold font are obligatory.
Click Next after having entered all information.
As a next step, please review the data you entered and click Finish to send the XML file to AceBIT using your default e-mail client.
After reviewing and validating the reported search service we may include it into one of our next database updates.

Basics 1: Content
The most important part of your website is its content - no surprise. Good, current content guarantees that users return. Here are some of the most
important things which you should bear in mind:

1. General:
Instead of wasting valuable time on tricks and manipulation, you should rather focus on keeping your content well arranged and interesting.
You should maintain your focus on your website's visitors.
Share your know-how with the world. You will be rewarded with loyal visitors, many recommendations and links to your site.
Concentrate on only a few topics in the beginning to be able to offer better content.
Select strategically important keywords for your site and add them to your text without cumulating too many which would displease a visitor.
Take care that the content you offer is up-to-date.

2. Style:
Separate advertising and content, because this will make your statements seem more reliable.
Start mentioning the most important information to attract interest.
Explain the technical terms you are using in your text, if necessary.
Pay attention to orthography, grammar and punctuation. Small mistakes will be tolerated, but if this should occur more frequently the reading
flow will be impeded and the text will appear less reliable.
Make sure that your sentences are as short and as precise as possible and that you do not use unnecessarily complex structures and topical
excursuses.
Structure your text for reason of clarity by using subheadings and use enumerations where it is appropriate instead of creating one large block
of text.

Basics 2: Design
Apart from content, the design of a website plays an important role as it will also affect a visitor. First of all it is most important that you have exactly that
visitor in mind when you choose a design and do not loose yourself in technical tricks and gimmicks just to show that you are able to. Instead you should
count on a simple and clean design. Let the following tips guide you:
Try to find a strategy concerning graphics and pictures which best fits your content: Pictures are helpful to demonstrate facts and valorate text
optically, but they can also distract people from the actual content when they are used too often, too centralized or too oversized.
Select a font and font size which your reader's will appreciate.
Make sure your texts are readable - dark lettering (best would be black) on a light background will have the best contrast and will help visitors
to read your text.
Be careful not to use too many colors, as a website which is too colorful does not communicate as much and can appear disturbing. In addition,
it is important to have a look at colors which are close to one another.
Consider which color represents your concept and content best. Plain colors which do not attract too much attention are often the better
alternative compared to shrill and noticeable colors - even when you like the latter personally.
Do not change structure and layout for any of your subpages.
If you use less elements and technical gimmicks, the load time of your website will be short which will certainly please your visitors.
Use known symbols for known functions, as for example the shopping cart icon for order pages.
Characterize links with one of the usual representations.
Use "Thumbnails" if you want to publish huge images to ensure that the load time is short and your site is clearly arranged.
Do not use too many animations and acoustical signals - if any - because this will annoy visitors sooner or later.
Offer a clear and easy-to-use navigation to your visitor so that he/she is able to find the right way.
Try to avoid that a visitor has to scroll horizontally.
Some more tricks and tips can be found on the Internet for example at
http://www.usabilityfirst.com/websites/design.txl

Basics 3: Domain Name
A further important step when creating your website is to choose a domain name. Here are some things that you have to think of:
The domain name you have chosen has to be free, so that you can register it.
Your domain name may not violate the right of third parties and companies. Big and well-known companies will generally have a prior right
about domain names as far as their name is concerned. In addition, you should be careful with names of stars and prominents, at least if you
haven't ask for permission first.
For company websites the name of the company would fit best. Customers who search for a company in the Internet will be able to remember
www.company.com very well.
It is helpful if you can add your most important keyword to the domain name. This will not only improve the ranking, but also tell a visitor what
he/she can expect on your website.
A short domain name is easy to remember for a visitor.
A concise name may be better than a fantasy construction or abbreviation.
Make sure to use known and generally accepted top level domains like .com, .net, .info or similar.

Basics 4: Specialization
Do not try to put all information in one huge HTML file, but specialize your pages.
Example: If your website deals with animals, create one page for elephants, one for tigers etc. A page with little content, in which the word
"elephant" is mentioned frequently, will be ranked higher than a 3 MB HTML file, in which "elephant" is just one word among thousands.
This little step can help be ranked considerably higher! In addition, your pages are much easier to read.

Basics 5: Technical details
Before submitting your website, make sure it is technically correct:
Your website does not trigger any error messages (e.g. it runs under standard browsers like Firefox and Internet Explorer).
File sizes of images are optimized.
Titel, meta tags and robots.txt are included for each site.
There is a Noframes section (only if you are using frames).
Your links work properly.
etc.
Tip: Use the different analysis tools in the Analysis and Tools sections to check your website for possible errors before you submit it to search services.

Search engine submission
Search engine submission or registration is the process of getting your website included in a search engine index. Many people believe that website
submission is not necessary, because the leading search engines like Google and Yahoo! use crawlers and bots to search and add URLs to the index. But this
can only happen if a site is already linked to sites in the index. In addition, directories, and smaller, regional search engines will never find your site. It is in
any case better to take matters into your own hands and to submit your URL instead of waiting until it will be found by a crawler. In addition, the search
engine submission will help you to get the first valuable backlinks for a new project.
With Hello Engines! you can submit your website both automatically and manually. With an automatic submission you can save a lot of time and energy:
You enter details about your website, select search services to which you like to submit your website and let the program do the rest.
However, there are situations, when only manual submission is possible. For example, some search services ask you to enter a generated code to avoid
receiving too much spam from submission tools. In addition, Hello Engines! does not submit your website automatically to those search services which are
not free of charge.
In general, it is not submit your website more than once to search engines and directories. Search engine crawlers update the information about your page
automatically at regular intervals, once you have been accepted into the index. Only if there are major changes, i.e. translate it into another language or
completely change the content, it is recommendable to repeat the submission.
You should take into consideration that most search engines take 6 weeks or more to index your website after submission. Don't panic when you can't see
an immediate response to your submission, but visit the search services at a later date again.

What are meta tags?
Meta tags enable you to give certain information about your website. This information is then read by search engines (not directories!), or better by their
robots. For example, the text entered through meta tag "description" should be displayed as a description of a page (i.e. a HTML document, not the whole
site) in a search engine.
Meta tags can help you to avoid problems with frames, tables, or other difficult elements. Meta tags help you control site descriptions in such search
engines that support this feature. You should use meta tags, but remember that they do not guarantee that your website ranks number one, or that it will
be displayed ideally.
Meta tags can be created in Hello Engines! using the integrated Metatag Generator.
Use the clipboard or the integrated editor to add the generated meta tags to your HTML files.
Here you will find some basic information about the according meta tags:
Author
Publisher
Copyright
Topic
Keywords
Description
Page-Type
Audience
Indexing
Expires (valid until)

Tools menu
In the Tools menu, you will find the following tools and wizards:
HTML Editor
Lost Unlock Key Wizard
Test Connection Wizard
Report Search Engine Wizard

Access data - Local system
To be able to optimize website documents which are stored on your local system, you need to specify the
Default File Name on the server (that is for example index.html or default.htm) and
the Local Folder in which that file is located. Click the ... button to find the right folder.

Web Services
Directly from Hello Engines! you can access different Web Services which assist you in generating keywords. Proceed as follows:
1. Select the Web Service you would like to use from the list of Web Services.
2. The Web Service is opened in the integrated browser window. Enter the data which is needed by the Web Service and use the button which
starts the Keyword Generator.
3. Mark the words that you would like to use for your keyword list and click Extract keywords in the Hello Engines! menu.
Select those keywords that you would like to transfer to your keyword list and click OK.
Hello Engines! can save your login information so that you don't have to type it in each time you use that web service. Just click on New Account.

Competitors
It can be helpful to analyze the keywords that competitors use for their websites, so that you are able to reconsider or adapt your own keywords. To
analyze your competitor's websites take the following steps:
Enter an URL into the URL field and click ENTER to add it to the Competitor URLs below.
Mark one or - by keeping the Ctrl key pressed - more URLs in the list and click Scan Competitors to retrieve the keywords used by these
competitors. On the left side you are shown an overview over all keywords used and the number of occurrences.
Note: The number that you choose at AutoSelect from determines from which number of occurences on an element is automatically checked in the
list!
Select those keywords that you would like to add to your keywords list and click OK to do so.
With the help of the button Get Top URLs you can detect those competitors which have the best ranking for a certain keyword and add them to your
competitor URL list.

Keyword Combinations
With the help of the Keyword combination tool you can combine different keywords to possible groups.
You can, for example, combine different keyword lists. Take the following steps:
1. Enter different keywords for the different keyword lists manually or load a keyword list that you generated before from a file. The shown
keywords can be erased using the Clear button.
2. Determine how many combinations you like to have as a maximum
3. Click Generate Keyword Combinations to be shown the different combinations.
4. Select those combined keywords that you would like to add to your keyword list and click OK.

Robots Site Scanner
The Site Scanner in the Robots Generator section helps you to read the structure of your site and to select directories which you want to be locked for
the selected agents.
To use it, enter an URL into the field URL to scan. As a next step, decide if you would like to have only HTML files and if you would like to have only
internal links. From the list, choose what link HTML tags you want to be used for the scanning. Select All to activate or deactivate all possibilities. Click
Scan to start the scanning process.
The Site Content section shows you the results of your scan. By clicking on a folder, you can see its content displayed in the File name area. Double-click
on an item or drag and drop it into the Disallow list.
Note: You have to select an agent in the list in order to add items to the Disallow-List.
If you select the option Clear content on new project, the site content is automatically deleted if you start a new project.

Import meta tags
Select the desired source using the Import button.
The Metatag Generator can import meta tags from the following sources:
Import from file: The details from a details file (*.SIT) are imported as meta tags.
Import from project: The details given under Data are imported as meta tags.
Import from HTML: Meta tags are imported from a local HTML file.
Import from URL: Meta tags are imported from a website.
Note: You should be connected to the Internet.

HTML Editor
The HTML Editor is a useful tool if you want to edit HTML documents, e.g. add meta tags.
On the HTML tab you can Save and Upload the current document. To open a html file which is saved locally, click Open File. Here you can make direct
changes to this page. To use text from the clipboard click the Paste button. In addition you have the possibility to Find or Replace words or phrases.
Furthermore, you have the possibility to see a print preview and print it. To see all headings, links or iamges at a glance, click the according button on the
right side of the toolbar. All according elements will then be shown below the source code. To see all errors in the HTML code, click Errors.
Metatags and Refresh values can be edited at the Metatags tab. Add or edit the title, the keywords and the description metatag and select the desired
option for Robots, for example INDEX;FOLLOW if you want robots to add your site to the index and to follow links on that site. To set a Refresh tag for
the according site so that it is automatically refreshed or redirects to another website after a certain time, select a Delay value (in seconds) and enter the
URL of the second website to which a user will be redirected.

Social Website
In the dialog to create a new social bookmarks website you need to fill in the following fields:
Name: Enter here a description of the social bookmark site, for example "Mister Wong".
Location: Enter the URL which is used for direct log-ins.
User name
Password
Comments: Here you can add some personal comment about the website.

Author (meta tag "author")
Type in the author of your website. You may also enter your name, your company's name or the webmaster's name.
If you click Import you can choose if you would like to import data from a file, a project, a HTML file or an URL and ASEOPS selects an entry
automatically, if there is any.

Publisher (meta tag "publisher")
Type in the publisher of your website. You may also enter your name, your company's name or the webmaster's name.
If you click Import you can choose if you would like to import data from a file, a project, a HTML file or an URL and ASEOPS selects an entry
automatically, if there is any.

Copyright (meta tag "copyright")
Type in the copyright information of your website. You may also enter your name, your company's name or the webmaster's name.
If you click Import you can choose if you would like to import data from a file, a project, a HTML file or an URL and ASEOPS selects an entry
automatically, if there is any.

Topic (meta tag "page-topic")
Enter your website's topic. Select from the drop-down list or type in your own topic.
If you click Import you can choose if you would like to import data from a file, a project, a HTML file or an URL and ASEOPS selects an entry
automatically, if there is any.

Description (meta tag "description")
Enter the description of your website.
If you click Import you can choose if you would like to import data from a file, a project, a HTML file or an URL and ASEOPS selects an entry
automatically, if there is any.

Page type (meta tag "page-type")
Type in the page type category which describes your website best.
If you click Import you can choose if you would like to import data from a file, a project, a HTML file or an URL and ASEOPS selects an entry
automatically, if there is any.

Audience (meta tag "audience")
Select the audience for your website.

Indexing (meta tag "robots")
Select an option to indicate the search engines' robots how to index your website. The following options are available:
Index, follow all links
Index, do not follow links
Do not index, follow all links
Do not index, do not follow links

Get Top URLs
This option allows you to retrieve those URLs which have the best ranking for a certain keyword.
1. Enter a keyword.
2. Select the search engine which will be the base for the analysis from the list .
3. Determine the number of URLs you would like to get.
4. Click OK to get the Top URLs.
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